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Preface

Thank you for purchasing OKI Multifunctional Digital Systems or Multifunctional Digital Color Systems. This manual
explains the instructions for the Fax driver. Read this manual before using your Multifunctional Digital Systems or
Multifunctional Digital Color Systems. Keep this manual within easy reach, and use it to configure an environment that
makes best use of the OKI MFP’s functions.

To use this function, the scanning function (Internet Fax) and printing function (Network Fax) are required.

Bl How to read this manual

0 Symbols in this manual

In this manual, some important items are described with the symbols shown below. Be sure to read these items before
using this equipment.

A WARNING Indicates a potentially hazardous situation which, if not avoided, could result in death, serious
injury, or serious damage, or fire in the equipment or surrounding objects.

A CAUTION Indicates a potentially hazardous situation which, if not avoided, may result in minor or moderate
injury, partial damage to the equipment or surrounding objects, or loss of data.

Indicates information to which you should pay attention when operating the equipment.

Other than the above, this manual also describes information that may be useful for the operation of this equipment with
the following signage:

Tip Describes handy information that is useful to know when operating the equipment.
[ Pages describing items related to what you are currently doing. See these pages as required.

O Screens and Operation Procedures

* In this manual, the screens and the operation procedures in Windows are described for Windows 7.
The details on the screens may differ depending on how the equipment is used, such as the status of the installed
options, the OS version and the applications.

* If you use Windows Server 2008 R2, refer to the operation procedure for Windows 7, though the screens or the menu
names, etc. may differ.

* The illustration screens used in this manual are for paper in the A/B format. If you use paper in the LT format, the
display or the order of buttons in the illustrations may differ from that of your equipment.

* In this manual, the initial values of the setting items are underlined.
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O Trademarks

* The official name of Windows XP is Microsoft Windows XP Operating System.

* The official name of Windows Vista is Microsoft Windows Vista Operating System.

* The official name of Windows 7 is Microsoft Windows 7 Operating System.

* The official name of Windows Server 2003 is Microsoft Windows Server 2003 Operating System.

* The official name of Windows Server 2008 is Microsoft Windows Server 2008 Operating System.

* Microsoft, Windows, Windows NT, and the brand names and product names of other Microsoft products are
trademarks of Microsoft Corporation in the US and other countries.

* Apple, AppleTalk, Macintosh, Mac, Mac OS, Safari, and TrueType are trademarks of Apple Inc. in the US and other
countries.

* Adobe, Acrobat, Reader, and PostScript are either registered trademarks or trademarks of Adobe Systems
Incorporated in the United States and/or other countries.

* Mozilla, Firefox and the Firefox logo are trademarks or registered trademarks of Mozilla Foundation in the U.S. and
other countries.

¢ IBM, AT and AlX are trademarks of International Business Machines Corporation.

e NOVELL, NetWare, and NDS are trademarks of Novell, Inc.

e Other company and product names given in this manual or displayed in this software may be the trademarks of their
respective companies.
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OVERVIEW

This chapter provides an overview of the Network Fax features.
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Features and Functions

This equipment provides the network fax features, which simplify and facilitate your office facsimile needs and enables
you to send fax or Internet Fax digital documents directly from your desktop.

* Fax transmission using the Fax driver is available only when the optional Fax unit is installed.
* Please enable the SNMP setting on TopAccess to use the Fax functions. In addition, the Fax driver does not work
if the SNMP setting on TopAccess is disabled when the optional Fax unit is installed.

The highly intuitive, network Fax driver software enables you to select the fax printer driver to electronically fax or Internet
Fax from your computer to one or more recipients. You can easily define fax job properties from the send list to fax
resolutions. The Fax driver is complimented with the AddressBook Viewer. The combination of applications enables you
easily to manage a selection of fax recipients and access to the address book.

The Fax driver enables you to set up send lists and send electronic documents from your PC to one or more destinations.
You send to the fax in much the same way you would choose to print to a designated printer that makes using the Fax
driver quick and simple. You can select the fax properties. Fax properties are the attributes you can set to define sender
and recipient information for processing fax jobs such as dialing options, sender information, fax resolution and page
layout.

Other features include an easy-to-use fax scheduler that allows you to set up a date and time to transmit your fax. Cover
page options are also provided. You can include a customized cover page with your fax transmission that can contain
sender and recipient fax information and a detailed message. You can easily maintain sender and contact information that
can be printed on the cover pages.

Faxing hard-copy documents must be performed from the touch panel display.

Tips

* The image quality of the originals that are sent by the Fax driver is different from the originals that are sent by the
general fax operation.

* If you specify the Email addresses as the recipients using the Fax driver, the document will be sent as an Internet
Fax. The Internet Fax feature allows users to send originals the same as the fax features. However, an Internet Fax
is sent through the Internet, although a fax is sent through the public switched telephone line. In order to send an
Internet Fax, the remote device also must support the Internet Fax feature.

For more details about the Internet Fax, refer to the Scanning Guide.
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SENDING A FAX

This chapter describes how to send a fax using a Fax driver.

BasiC Procedure ... s 8
Specifying ReCIPIENES .....cccceeeeeeeeeeee ettt 12
Entering recipients from the KEYDOAId.............ooiiiiiiiiii e 12
Selecting recipients from the address DOOK...........ooo i 14
Selecting recipients from the address book (Search option) ..........coooiiiiiii i 16
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Basic Procedure

The basic procedure for sending a fax (Network Fax / Internet Fax) is as follows.
You can use standard functions or set optional functions as well as the basic ones described in this section. For these

operations, see the following section.
Q) P.21 “SETTING OPTIONS”

1 Start the application software and prepare the document to be sent.

2 Select [Print] from the [File] menu in the application software.

Tip
The procedure for displaying the print dialog box may differ from the above depending on the application
software.

3 Select [OKI MFP Fax] for the printer and click [Preferences].
= Print @

Genersl

Select Printer
=] Fax N o]
am Series PS3 L%
= seriesxps © V]
« 1 b
Status: Ready Print4o fle [ Freferances |
Location:
Comment { F‘"EP"|E§2‘
FaEe Range
@ A Mumber of goples: 1 L
Selection Current Page
Pages: 1-65636 Collate
et For wpie ety e 12 128
[ Frint | [ Cancel | [ e |

The dialog box of the Fax driver properties appears.

Tip
Note that the command name to open the driver properties may differ from [Preferences] depending on the
application software.
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4 Click the [Send] tab and specify the recipients.

(%% Punting Preferences @

| Layout | Send

Send to ES

| Address Buok.. |
To
Dizplay Mame Fax Mumber / Addiess
Fl m b

0E Fax Number
[@] @ Intemnet Fay Address

ﬁ Resolution = Department Code %
B | Gtandard (200 100 dpi) - s 2

/| Hide Department Code

_ Cover Sheet: Server Mame:
@J |None v‘ - Select from v|

(D) [DeayedFa 11/11/2011 547 P =]
'-’ Save as File
TIFFIMULTI)
{ Restore Defaults | { Heln |

(——

» To specify recipients, enter them with the keyboard or select them from the address book.
P.12 “Specifying Recipients”

* On the [Send] tab, you can set the resolution of a fax cover sheet, etc. as well as specifying the recipients.
P.24 “Setting up the [Send] tab”

* On the [Layout] tab, you can set the size and the orientation of the paper.
P.23 “Setting up the [Layout] tab”

* On the [Cover Sheet] and [Sender Information Properties] tab, the sender information for adding a fax cover
sheet can be set.
P.26 “Setting up the Cover Sheet”
P.27 “Setting up the SNMP”

5 Click [OK].
120 Printing Preferences

| Layout| Send

Send to
Address Book.
I
: Diizplay Mame Fax Number / Addriess
User 001 012-3456-7890
User 002 123-4567-8300
User 002 234-5678-0012

Fl mn }

& @ Fax Humber

[@] ) Intemet Fay Address

- Riesalgtion: =B Department Code:
£ [ Standard (200 100 dpi] - el
| Hide Department Code
_ Cover Sheet; Server Mame:
DJJ | None - ‘ [ Seleat from x

(D) [ Delayed Fax 11/11/2011 550 PM £
j" | Save as Fil
TIFFMLUILTI)
[ RestosDefals | [ He |
Iﬁr [ conca |
[4\)

The transmission settings are determined and the Fax driver properties dialog box is closed.
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6 Click [Print] in the print dialog box on the application software.

= Print @
Genersl

Select Printer

Fax ]
Series P53
Series XPS

- @i

. 2

Status: Ready [T Print ta file
Locstion:

Comment: Find Printer..

Fage Ranee
@ Al

Number ofcoples: 1 z
Selection Current Page
() Pages 1-55535 Collate

! 2131 523
Enter either & single page number or 4 single 1} | gl

page range. For exemple, 51
[ Frint ,\g Cancel | [ Ay |
|
A\

A fax starts being sent.

Tips
* Note that the command name to print a document (send a fax) may differ from [Print] depending on the
application software.

* A waiting fax job can be checked or deleted through the managing jobs function in TopAccess. A sent fax

job can also be checked through the displaying job logs function in TopAccess. For details, refer to the
TopAccess Guide.

Cautionary points when LDAP authentication is used

When LDAP authentication is enabled on this equipment, you must specify an LDAP server in the [Server Name] box on
the [Send] tab before sending a fax.

2% Panting Preferences @
Layuul_. Send
Send to
| Address Book... |
Tm

Dizplay Mame Fax Murber / Address

0% @ Fax Number

[ Intemnet Fax Address

ﬂ Resolytion: o JDapartmenthda
B | Standard [200 # 100 dpi] - 5
/| Hide Departrment Code
_ Cover Sheet Server Mame:
DJJ |Nnne v‘ —-Select from — v]
ct from --—-
1
- LOAP0Z
() [CIDelayed Fa 11411/2011 GEO PR |LDAPO3 —
':_'_ | Save as File
TIFFIMULTI)
[ Bestore Defaults | [ Help |
(el

If you attempt to send a fax without specifying an LDAP server, the [Specify LDAP Server] dialog box will appear to ask
you to do so.

Specify LDAP Server @

‘fou have not selected any server For LDAP authentication.

Please select a valid server,

Server Name:

---- Select From --— &
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In this case, specify the desired LDAP server in the [Server Name] box and click [OK] to send the fax.

| ‘ou have not selected any server For LDAP authentication.

 Please select a valid server.

| Setver Mame: |
[Loapot iv]

[}31

You can make settings for LDAP authentication on the [Device Settings] tab.
P.29 “Setting up the [Device Settings] tab”
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Specifying Recipients

Up to 400 recipients can be specified in a single operation. To send a Network Fax, specify the fax number. To send an
Internet Fax, specify the Email address.

[ P.12 “Entering recipients from the keyboard”

P.14 “Selecting recipients from the address book”

P.16 “Selecting recipients from the address book (Search option)”
P.20 “Removing recipients”

Tip
To use the address book, you need to register recipients in the address book of AddressBook Viewer in advance.

If more than one recipient is specified in a single transmission, and a cover sheet is set in the Fax driver or a header
page is set to be printed on the recipient's device, all the recipient information may be printed. If you want to secure the
recipient information, avoid sending a fax to multiple recipients at the same time.

H Entering recipients from the keyboard

You can enter a recipient with the keyboard.

For the recipient of a Network Fax, click [Fax Number] and enter the fax number in the

right-hand box. For one of an Internet Fax, click [Internet Fax Address] and enter the
Email address in the right-hand box.

(%1 Printing Preferences @
| Layaut| Send
Sendto
[ AdiressBook. |
To
Digplay Name Fax Mumber / Address
Fi T b
R —
[z @ Fax Mumber 1234567850 SUB/EWD

[ Intermet Fay Address

% Fesolution: =, Department Code:
B | Standard (200 + 100 dpil | =

/| Hide Department Code

D Cover Sheet: Server Name:
J ‘ Hone - | = Select from ---- T
¢) | Delayed Fax 1171142011 5:50 P
“ | Save as File
TIFF(MULTI)
Eeslme Detaults | ﬂa\p ‘
e
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Tips

* When you enter a fax number, you can also enter a sub address and a password. Click [SUB/PWD] to enter
them (within 20 digits each) in the dialog box. Entering them enables the document to be transferred from
the recipient’s device to that of the sub-address, as the communication is in compliance with ITU-T n

standard. However, in order to use this function, the recipient’s device must be a model in compliance with
the ITU-T standard.

SUB/PWD 5

SUE: PO
12345675901 234567590 12345675901 234567590
| (8] 4 || Cancel |

e Use “-" (hyphen) if you send a Network Fax with pauses (approx. 3 seconds) inserted in the fax number.
2 Click[_* |,

(=4 Printing Preferences @

| Layout | Send

Send o
| Address Book.. |
Ior

Dizplay Name Fax Number / Addriess
1234567850

[Jia| @ Fax Number %

[@] 7 Intemet Fax Address

ﬂ Resalution: o JDEpartmenthde
B | Standard (200 % 100 doi) v Bl

| Hide Department Code

Cover Shest: Server Mame:
DJJ |Nona " | = Selaet fram — =
MNMP Settings
(D) [T Delayed Fax 11/171/2017 550 FM Edi
‘)_‘ Save as File
TIFFMULTI)
[ Hestore Defaults ] [ Help |
o)

The recipients selected for “To” are listed.
Tip

When the fax transmission is completed, the recipients are automatically removed from the “To” list.
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H Selecting recipients from the address book
Select a recipient from the address book in the AddressBook Viewer.

1 Click [Address Book].

2% Panting Preferences @

Layout | send

Sendto

‘ Address Book... |
To RS

: Dizplay Mame Fax Mumber / Address

0% @ Fas Number

[@&] Intemnet Fax Address

ﬁ Resolytion: =3 Depatment Code:
== | Standard (200 % 100 dpi) - Exe
/| Hide Department Code
_ Cover Sheet Server Mame:
DJJ | Hione = ‘ | — Select from -— T
dit.
(D) [DslayedFan 11172011 550 PM Ed
‘t‘ | Save as File
TIFF(MULTI)
[ Bestore Defaults | [ Help |
| 0K | Cancel |

The AddressBook Viewer runs.

When selecting a fax number after selecting a contact from the contact list, click [Select
Fax] and when selecting an Email address, click [Select Email].

Ll AddressBook Viewer =N =R ==
File Edit View Toals Help
Ew

EREE] #ddress Book
Private dddress Book
Public Address Book

Dizplay Mame Fau Mumber Email Address it

MAP| Addrass Book 123-4567-8901 Userl02@example.com
‘windows Mail Address Book 1 234-5678-9012 Userl03@example.com

LOAP Address Book 345-6789-0123 Userl04@example.com
Import Address Baok 456-7890-1234 Used05Eexample.com -
4| 1 3
* Select Fax ‘ * Select Email |
ﬁl Selected Fax: & Selected Email h.’
[
Dizplay Mame OTID  GroupMName  Fax Mumber Dizplay Mame OTID  Group Mame  Email Address
] n 3 K T ;
Femove Fiemove
QK Cancel ] [ Help ]

The total number of the contacts: 10/3000

The selected recipients are listed in the “Selected Fax” or “Selected Email”.
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A contact, for which only a fax number is registered, cannot be displayed in the “Selected Email” and a contact,
for which only an Email address is registered, cannot be displayed in the “Selected Fax”.

You can select a recipient by the following operations:

Selecting a contact by dragging and dropping
Drag a contact in the contact list and drop it to the “Selected Fax” or “Selected Email”.

Selecting a contact by double-clicking on it
Double-click on a contact in the contact list. To change the setting of the recipient to be selected upon double-

clicking, select [Default Configuration], [Type Selection] in the [View] menu and then one of [Fax], [Email] and
[Both].

Selecting a contact from a shortcut menu
Right-click on the contact in the contact list, select [Select] from the shortcut menu and then either [Fax Number]

and [Email].
Removing a recipient

Select a recipient in the “Selected Fax” or “Selected Email” and click the corresponding [Remove] (Left: fax
number, Right: Email address).

3 Click [OK].

0 AddressBook Viewer E@
File Edit View Toals Help
]
CREE] Address Book Display Name Fax Mumber Email Address =~
Private Address Book
PZ‘I;‘;ceAddl:sszoDoi 5[] Userdo 012-3456-7890 Usedi &example com| =
MAP| Address Book Nz Usernnz 123-4567-8901 Userd02@example.com
‘windows Mail Address Boak HElE] Useroz 234-5678-9012 UserD03Eesample.com
-] LDAP Address Book el Ugern0d 345-6789-0123 User04{@example.com
+ Import Addiess Book =& UserD05 456-7890-1234 Useld05Eesample.com -
g I 3
* Select Fax
el Selected Fam & Selected Email
Dizplay Mame OTID  GroupMame  Fax Mumber Drizplay Mame aTID  Group Mame  Email Address
User003 3 234-8678-9012 Usger003 3 User003@exam. .
Uszer001 1 012-3456-7830 Usger002 2 Usger002@enam...
4 I, k4 1 b
Remaove Femave
[1]:4 | Cancel | | Help

The total number of the contacts: 10/3000

The AddressBook Viewer is closed and the recipients selected for “To” are listed.
Tip

When the fax transmission is completed, the recipients are automatically removed from the “To” list.
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H Selecting recipients from the address book (Search option)
You can find and select a recipient from the address book in the AddressBook Viewer.
1 Click [Address Book].

(21 Printing Preferences @

| Layout | send

Sendta

| fddress Book... |
e § Aemove

Dizplay Marme Fax Murnber / Address

0E @ Fax Number

[ Internet Fax Address

ﬁ Rezolution: 3 Department Code:
=eted \Slandard (200 % 100 dpi] '| [

/| Hide Department Code

Cover Sheet: Server Name:
DJ—' ‘Nnne 'l | Select from ---- X

(D) [IDelayedEan 171172011 550 b =
:__ | Save as File
TIFF{MULTI)
[ Bestore Defaults | [ Help I
()
The AddressBook Viewer runs.
2 Select [Find] from the [Edit] menu.
L) AddressBook Viewer =R
File View Tools Help
Copy Ctrl+C
Paste Ctrl+V
Digplay Mame Fawx Mumber Email Address it
Select All Curl+A
HzE] U serm 012-3456-7890 Userl01 @example.com| =
123-4567-8301 Userl02(@example. com!

234-5678-9012 Userl03@example. com
345-6789-0123 User0d(@example. com
456-7390-1234 Userl05@example.com -

Pddress Book
Irmport Address Book

1 2

~ Select Fay ‘ = Select Email
el Selected Fax @ Selected Email:
Display Mame OTID  GroupName  Fax Number Digplay Mame OTID  Group Mame  Email Address
< i R K i o
Remave Remove
ok Cancel | [ Hels |
Search for contacts The total number of the contacts: 10/3000

The [Find Contact] dialog box appears.
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3 Select a registered directory service in [Data Source].

Find Contact

Data Source: Frivate Address Book vJ
——— Private Address Book.
Person | Detall ST aTeye] 0ok
MAPI Address Baok k
. ‘Windows Mail Address Book
Display Mame; Impoit &ddress Book

Fax Mumber:

Email:

Group Mame Display Name Fax Number Email Address Dep

d 1. (it

el Selected Faw: (7] Selected Email

Dizplay Marne OTID  GroupMame  FaxMul| Display Mame OTID  Group Mame  Email &

< r I s
7Eﬂel | | Help |

Tip

To change the setting of the default address book in the [Data Source] box, select [View] - [Default
Configuration] - [Data Source] and then choose an address book.

4 Display the [Person] tab and enter search strings in the following boxes.

Find Contact

DataSowce: | Public Address Book -

Persony | Detal Setting
Displaﬁlame: User

Fax Mumber:

Email:

Search ‘

Group Mame Display Name Fax Number Email Address Dep
< m b
Uzl Selected Fax %] Selected Email
Dizplay Marne OTID  GroupMame  FaxMul| Display Mame OTID  Group Mame  Email &
4 b [ 3

[ Cencel [ Hep ]

Display Name — To search display names, enter a search string here.
Fax Number — To search fax numbers, enter the numbers here.
Email — To search Email addresses, enter a search string here.

If you perform searching in the above conditions, proceed to step 6. If you want to set more detailed search
conditions, proceed to step 5 and set the [Detail Setting] tab. Note that even if you enter the search conditions in
both the [Person] and [Detail Setting] tabs, you cannot perform searching in this combination.

Tip
In the [Person] tab, you do not have to fill in all the boxes and the string does not need to completely

correspond to the target of the search. Entering one or more characters in one or more boxes causes a search
to be made for contacts which correspond to the particular conditions.
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5 Display the [Detail Setting] tab, set the search condition, and then click [Add].

Find Contact

Data Source: I Public &4ddress Book -

Person | Detail Setting

Define Condition: %1

Field Select: ondition of search skring:
iD\spIay NMarme = | |Starts with - | User

Condition list: %

TN
~ %3 [ Sesch |

Group Name Dizplay Mame Fax Number Ermail Address Dep
« m »
W) Selected Fax: 7] Selected Email
Digplay Name 0TI Group Mame  FasMul | Digplay Name 0TI GroupMame  Email &
“ {11} L3 ‘ n L3

| Cancel | ‘ Help |

Field Select — Select an item to be searched.
Condition of search string — Select a condition in the left-hand box, and then enter a search string in the right-
hand box.

* The search condition is displayed in the “Condition list”.
* To set more than one search condition, repeat this operation as many times as needed.
* To delete the search conditions, select one and click [Remove].

6 Click [Search].
Find Contact

Data Source: I Public &ddress Book -

Pergon | Detal Setting

Define Condition:

Field Select: aondition of search string:
iD\spIay Mame: o | |Cuntain5 -
Condition list:

| Display Mame Starts with User

Group Mame Display Mame Fax Mumber Email Address
< m b
Jei) Selected Fax: (7] Selected Email
Display Name 0TI Group Mame  Fax Mul | Display Name 0TI Group Mame  Email &
% Tl bl e T 3

| Cancel || Help |

» |t starts searching contacts in the selected address book. When the search is complete, the contacts matching
the search conditions are listed.
» To stop searching, click [Stop].

Even if you enter the search conditions in both the [Person] and [Detail Setting] tabs, only the search condition
in the tab currently displayed is used. You cannot perform searching in the combined conditions on both tabs.
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Drag and drop the contacts to “Selected Fax” or “Selected Email” from the list of the
search results.

Find Contact @
Data Source: Public: &ddress Book -
| Person | Detail Setting |
Define Condition:
Field Select: ondition of search skring:
Display MName - | |Cuntains - |
Condition list: .
| Display Mame Starts with User

Remove

| Group Mame Dizplay Mame Fax Number
Userdd1
Useo2
Userl03

" m

Ernail &ddress
UzerD ey

W) Selected Fax:

7] Selected Email

Dizplay Mame OTID GroupMame  FaxMul | Display Mame OTID  Group Mame  Email &

| Cancel | ‘ Help |

The selected recipients are listed in “Selected Fax” or “Selected Email”.

A contact, for which only a fax number is registered, cannot be displayed in the “Selected Email” and a contact,
for which only an Email address is registered, cannot be displayed in the “Selected Fax”.

You can select a recipient by the following operations:

Selecting a contact by double-clicking on it

Double-click on a contact in the list of the search results. To change the setting of the recipient to be selected upon
double-clicking, select [Default Configuration], [Type Selection] in the [View] menu and then one of [Fax], [Email]
and [Both].

Selecting a contact from a shortcut menu
Right-click on the contact in the list of the search results, select [Select] from the shortcut menu and then either
[Fax Number] or [Email].

Removing a recipient
Select a recipient in the “Selected Fax” or “Selected Email” and click the corresponding [Remove] (Left: fax
number, Right: Email address).
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g Click [OKI.

[Public Adsress Brok

Data Source:

Dretail Setting

Define Condition:

Field Select: Zondition of search skring:

User0n3 234-5

[Dgnl_qy Marne: > I [Cantams ¥
Condition list:
Display Mame Starts with User | fdd |
Search
| Bemove
[ Swp |
Group Name Dizplay Mame Fax Number Ermail Address [
UserD01 012-3456-7890 User001 {&example.com [D
| Userl02 123-4567-3301 Userl02@example.com it
Userd3@example.com [l

E7E-9012

1 (T

V) Selected Fax

7] Selected Email

Digplay Name 0TI Group Mame  FasMul| Display Name 0TI GroupMame  Email &
User001 012-348| Userln2 User0;
10 (Tl ol T v
‘ Remove Remave ‘
KN [ Concel |[ Hep |

‘5

The AddressBook Viewer is closed

Tip

When the fax transmission is completed, the recipients are automatically removed from the “To” list.

l Removing recipients

You can remove a recipient from the “To” |

and the recipients selected for “To” are displayed on the list.

ist in the Fax driver properties.

1 Select a recipient and click [Remove].

Layout | Send

Sendto

Address Book

_ Remove

Display Name Fax Humber / Address

[ % |
(5 @ Fax Mumber SUB/PWD .. |
[@] ) Intemet Fay Address ‘ |
E Resolution: =5 Department Code:
[Stendard 200 » 100 2pi 2 e
[¥] Hide Depattment Code
E Cover Sheet: Server Mame:
[Wone 7] [~ Select from -~ x|
Edit [ SHMP Sethings |
@ [ Delayed Fax [11711/2011 5:50 b [ Ede.
'?j Save asFile Flile Fomat:
[TIFFBULTI) -]
Restare Detaults . Help

The selected recipient is removed.
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SETTING OPTIONS

This chapter describes how to set up options for the Fax driver.
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How To Setup

There are two ways to set the Fax driver options: One is to set the initial values of the options and the other is to set each
option for each individual job.

) P.22 “Setting Initial Values of the Fax driver options”

3 P.22 “Setting print options for each print job”

H Setting Initial Values of the Fax driver options

Setting the Fax options by displaying the Fax driver properties from the Printers folder on the Windows [Start] menu will
establish the initial values of the options.

1 Click the Start button and then select [Devices and Printers].
When using Windows XP / Windows Server 2003, click [Start] and select [Printers and Faxes].
When using Windows Vista / Windows Server 2008, click [Start] and select [Control Panel], [Hardware and Sound]
and then [Printers].

2 Right-click [OKI MFP Fax], and then select [Printing preferences] or [Printer properties]
from a shortcut menu.

* When using Windows XP / Windows Vista / Windows Server 2003 / Windows Server 2008, select [OKI MFP
Fax], click the [File] menu and then select [Printing Preferences] or [Properties].
 If [File] menu is not displayed, press [Alf].

H Setting print options for each print job

Setting the Fax driver options by displaying the printer properties from the Print dialog box within an application will
establish the values for the current Fax job. The Fax driver option settings specific to each Fax job are set using this
method.

1 Click the [File] menu and select [Print] on an application.
2 Select [OKI MFP Fax] and click [Properties] or [Preferences].
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Setting up the Fax Driver Options

Fax driver options are the attributes to define the way a fax job is transmitted. For example, you can specify the recipients,
resolution, and paper size.

P.23 “Setting up the [Layout] tab”

P.24 “Setting up the [Send] tab”

P.26 “Setting up the Cover Sheet”

P.27 “Setting up the SNMP”

P.29 “Setting up the [Device Settings] tab”

P.30 “Setting up LDAP servers” n

H Setting up the [Layout] tab

On the [Layout] tab, you can set the size and the orientation of the paper.

=W Fax Printing Preferences @
Layout | Send
1 Onentation:
-
Advanced... 2

1) Orientation
Set the printing orientation of the document.
- Portrait — Data are printed vertically to the paper.
- Landscape — Data are printed horizontally to the paper.

2) [Advanced]
Click this to display the [Advanced Option] dialog box. You can select the paper size of the document.

U EaxAdvanced Options ===
”g} s Fax Acvanced Document Settings
(=5 Paper/Qutput
Letter -
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H Setting up the [Send] tab

In the [Send] tab, you can specify the recipients and how the fax will be sent.

1)

2)

3)

4)

5)

6)

7)

(2= Printing Preferences
Layout | Send [
Send to
1 | Address Book. |
o Il | e fooze ] —— 3
Dizplay Name Fax Mumber / Address
Fi m b
4 ——— 0¥ @ Fax Humber B/PWE —_5
6 — ] Internet Fay Address
7 s Resolution: '___\_:Departmentgnde' ———————— 8
# | Standard (200 » 100 dpi) - [ [
[¥] Hide Depattment Code  ——— 9
_ Caver Sheet: Server Mame; 1 2
10 @J [Wore | [LoaPm -
11 Edi SHMP Setting —— 13
14 ——— (V) [[DelapedFax 111142011 B:02 PM i
15 —— & Dsaveasfic 16
‘ o TIFF(MUILTI)
17 —_— Hestare Detaults [ Help | —— 18
)

[Address Book]
Click to launch the AddressBook Viewer. You can select recipients from the address book.
P.14 “Selecting recipients from the address book”

To
This displays the specified recipients list.
P.12 “Specifying Recipients”

[Remove]
Select a recipient in the [To] list and click this to remove the recipient from the list.
P.20 “Removing recipients”

Fax Number
Enter the recipient’s fax number directly.
P.12 “Entering recipients from the keyboard”

[SUB/PWD]
Click this to display the [SUB/PWD] dialog box. You can add a sub address and a password to the entered fax number.
P.12 “Entering recipients from the keyboard”

Internet Fax Address
Enter the recipient’s Internet Fax number directly.
P.12 “Entering recipients from the keyboard”

Resolution

Select the resolution for the fax.

- Standard (200 x 100 dpi) — Select this to send a document in Standard mode (200 x 100 dpi).

- Fine (200 x 200 dpi) — Select this to send a document in Fine mode (200 x 200 dpi).

- Super Fine (200 x 400 dpi) — Select this to send a document in Super Fine mode (200 x 400 dpi).
- Ultra Fine (400 x 400 dpi) — Select this to send a document in Ultra Fine mode (400 x 400 dpi).
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8) Department Code
Enter a department code of 1 to 63 characters if required. When the department code is enabled on this equipment,
you must enter it to send a fax.

* If you do not enter a department code when it is enabled on the equipment and the Invalid Department Code
Print Job is set to “Store to invalid job list” in TopAccess, the job will be stored in the Invalid job list without being
transmitted. You can print or delete a stored job from the [JOB STATUS] on the touch panel. For instructions on
how to print or delete a job in the Invalid job list, refer to the Printing Guide.

* If you do not enter the department code when the department code is enabled on the equipment and the Invalid
Department Code Print Job is set to PRINT in TopAccess, the job will be sent.

» If you do not enter the department code when the department code is enabled on the equipment and the Invalid
Department Code Print Job is set to DELETE in TopAccess, the job will be deleted automatically.

9) Hide Department Code
Select this check box to display a department code in the blank symbols.

10) Cover Sheet
Select a cover sheet type among [Standard Cover Page], [Business Cover Page] and [Professional Cover Page] if you
want to attach a cover sheet to the first page of the document.
P.33 “Sending with a cover sheet”
P.40 “Cover Sheet Samples”

11) [Edit]
Click this to display the [Cover Sheet Settings] dialog box. You can perform various kinds of editing on the cover sheet
selected in the Cover Sheet setting, such as entering a subject or a message, or changing the type or size of the fonts.
P.26 “Setting up the Cover Sheet”

12) Server Name
Select the desired LDAP server in the [Server Name] box if needed.

Tip

You can make settings for the LDAP server on the [Device Settings] tab.
P.29 “Setting up the [Device Settings] tab”

13) [SNMP Settings]
Click this to check or change the SNMP settings.
P.27 “Setting up the SNMP”

14) Delayed Fax
Select this to send a document on a specified date and time. When this is selected, click [Edit] to display the
[Scheduled Time] dialog box and specify date and time the job will be transmitted. The job sent to this equipment will
be stored in the Fax queue until the specified date and time.
P.32 “Delayed transmission”

15) Save as File
Select this to save up to 10 GB of documents in the “FILE_SHARE” folder in the equipment as well as send the
document as a fax and Internet Fax.
1 P.31 “Saving a fax as a file”

Tip
When the cover sheet is set, the cover sheet and the original will be stored in the “FILE_SHARE” folder.

16) File Format
Select the file format of the document that will be saved. This option can be selected only when the [Save as File]
check box is selected.

17) [Restore Defaults]
Click this to restore the default setting values.

18) [Help]
Click this to browse Help for the Fax driver.
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H Setting up the Cover Sheet

You can set the content of the cover sheet to be attached to a fax.
P.33 “Sending with a cover sheet”

1)

2)

3)

4)

5)

6)

Caver Sheet Settings @
Cover Shest Mame:
[ FACSINILE TRANSMITTAL | Standard Cover Page
Header Text
FACSIMILE TRAMNSMITTAL — 4
Text Area Details
1 Reference Number 5
Recipients Information 6
Name Company
Department Name Fax Mumber
Sender Information 7
2 — Farts
Fant Far:
|Header 'I | Edit... |
3 = Footer
Subject 8
Image File:
b Message 9
1 0 —_— Restore Defaults
0K | ‘ Cancel | | Help
Preview

The image of the cover sheet can be previewed. You can check the layout of the character strings and images.

* Depending on the line feed positions, the preview may not duplicate the actual print result of the cover sheet,
but is used for checking its layout.

» If the contents are on more than one page, such as the many line feeds included in “Sender Information” or
“Message”, only the first one page is displayed in the preview.

Fonts

Select the font to be used for the cover sheet. Select the section for which the font is used, and then click [Edit] to

select the type, style and size of the font.

- Header — Set the font to be used for the header of the cover sheet.

- Title — Set the font to be used for the title such as Reference Number, Recipients Information, Sender Information,
Subject or Message.

- Body — Set the font to be used for the body of each title.

Footer

Select an image file to be attached to the footer of the cover sheet.

- [Browse] — Click this to select an image file to be attached to the footer within 1 MB.
- [Delete] — Click this to delete the attached image file.

- Position — Select the position of the image file from the left, center and right.

Header Text
Enter a title to be displayed on the header of the cover sheet; it can be up to 63 characters.

Reference Number
Check this to have a reference number identifying the fax to appear on the cover sheet. Enter the reference number in
the text box.

Recipient’s Information

Check this to have the recipient’s information appear on the cover sheet. Select the desired information among the
options below.

- Name — Check this to have the recipient name appear on the cover sheet.

- Company — Check this to have the recipient company name appear on the cover sheet.

- Department Name — Check this to have the recipient department name appear on the cover sheet.

- Fax Number — Check this to have the recipient fax number or Email address appear on the cover sheet.
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7) Sender Information
Check this to have the sender’s information appear on the cover sheet. You can enter the information in up to 500
characters.

8) Subject
Check this to have a subject appear on the cover sheet. You can enter the subject in up to 40 characters.

9) Message
Check this to have a message appear on the cover sheet. You can enter the message in up to 500 characters. n

10) [Restore Defaults]
Click this to restore the default setting values.

H Setting up the SNMP

If the recipient’s OKI MFP is not found over the Internet and the fax job is not sent normally, the SNMP settings may be the
cause. Check that the SNMP settings are correct in the [SNMP Settings] dialog box, and if not, change them.

Ask the administrator for details on the SNMP Network settings configured for your OKI MFP.

SHMP Settings
1 ———— version
@ vijvz i WijNza
2 1 ShMP w2
Community Mame:
private
3 SHMP '3
User I0 File:
User Mame/Password:
HMAC-MDS
Nane
4 __| Restore Defaulk I I oK. | | Cancel
1) Version

Be sure to have the correct SNMP version set for your OKI MFP and select from the following options:

- V1/V2 — Select this option to enable SNMP V1 and V2.

- V3 — Select this option to enable SNMP V3.

- V1/V2/V3 (for [Discovery Settings] dialog box only) — Select this option to enable SNMP V1, V2, and V3.
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2) SNMP V1/V2

Community Name — If a community name other than “private” (default) is set for the SNMP community name for your
OKI MFP, enter its community name.

* To send fax jobs normally under an SNMP V1/V2 environment, the SNMP community names must be the same
in the 3 settings shown below. For help, ask your administrator.

- Your OKI MFP
- [SNMP Settings] dialog box of the [Sender Information] tab
SHMP Settings
Yersion
@ W1z W3 VIMvZING

SNMP (Y2
Community Mame:

private

SHMP Y3

- TCP/IP port of the [Ports] tab in the Fax driver

Configure Standard TCP/IP Part Manitar
Puort Settings
Port Mame: IP_157.69.73.252

Printer Mame or IP Address: 157.69.73.252

Protocol

@ Raw LPR

Raw Settings
Port Mumber: 9100

LPR Settings

LPR Byte Counting Enabled

/| SHMP Status Enabled

Community Name: private

SHMP Device Index 1

ok [ Concd |

* To change the community name, the administrator privilege is necessary. You must log in with the
“Administrator” privilege and open the printer driver properties.

* Up to 31 characters including the following symbols can be entered for the Community Name.
"#$%&'()*+,-/;<=>2@[\]1*"_"{I}~

3) SNMP V3
If SNMP V3 is enabled, select one of the following items to set how users are authenticated.
User ID File — Select this option when you want to use a user ID file. Click [Browse] and specify the user ID file.
User Name/Password — Select this option when you want to use the user name and password. When this option is
selected, keyboard or select the following items:
- User Name
- Authentication Protocol
- Authentication Password
- Privacy Protocol
- Privacy Password

* If you select to enable SNMP V3, consult your network administrator for preliminary advice on how to
authenticate users.

* Up to 31 characters including the following symbols can be entered for each of the User Name, Authentication
Password and Privacy Password.

1$%&"()-.<>@[1"_"{}~

4) [Restore Default]
Click this button when you want to reset all the settings back to the defaults.

28

Setting up the Fax Driver Options



H Setting up the [Device Settings] tab

On the [Device Settings] tab, you can change a setting for Fax driver update or display the software version of the driver.

1)

2)

3)

4)

5)

6)

Ask the administrator for details on the settings configured for your OKI MFP.

Details...

(o RS TR Fax Properties
General | Sharing | Ports | Advanced | Color Management | Security

1 — || pdate Automatically:

[on =)
2 —— User Authentication:

ot ~|
4 e F 2 FuIR LD

|Enabled ¥
5 e |1tEINEL F 22 Funclion:

|Enabled ¥

( " 7
6 — Wersion Information.. |

=)

Device Settings

l 0K ] ‘ Cancel ‘ | Apply

Help

Update Aut

omatically

Select whether or not the setting information of each item on the [Device Settings] tab of the Fax driver is to be
obtained by automatically communicating with your OKI MFP every time this tab is opened.

- On — Select this to obtain the setting information automatically.

- Off — Select this not to obtain the setting information automatically. Set each item manually.

User Authe

ntication

Select the authentication method which is to be used. Set it to correspond to that of your OKI MFP.
- On — Select this not to perform user authentication.
- MFP Local Authentication — Select this to perform MFP Local Authentication.

- Windows Domain Authentication — Select this to perform Windows Domain Authentication.

- LDAP Authentication — Select this to perform LDAP Authentication.

[Details]

When you click this button, the [LDAP Server Settings] dialog box will appear. This option can be selected only when

[LDAP Authentication] is selected in the [User Authentication] box.

P.30 “Setting up LDAP servers”

Fax Function
Select whether or not the fax function is enabled. Set it to correspond to that of your OKI MFP.
- Enabled — Select this to enable the fax function.
- Disabled — Select this to disable the fax function.

Internet Fax Function
Select whether or not the Internet Fax function is enabled. Set it to correspond to that of your OKI MFP.
- Enabled — Select this to enable the Internet Fax function.

- Disabled — Select this to disable the Internet Fax function.

[Version Information]

Click this to display the software version information of the Fax driver.

Wersion Infarmation @
Fax Driver
Versian:
Localize version:
Copyright {c) 2010 CORPORATION all Rights Reserved.
Copyright {c) 2001-2005 Jochen Katz, Frank Fock.
Copytight {c) 1996 Hewlett-Packard Company
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H Setting up LDAP servers
The [LDAP Server Settings] dialog box allows you to register LDAP servers.

1)

2)

3)

4)

5)

LDAP Server Settings

11— | Update Bow
22— Server Marme:

LDAPOS
3 —— dd
4——— server Mame List:

|LDAPOL

|LDAPOZ
5 —

[als I | Cancel |

[Update Now]

Click this button to obtain LDAP server information automatically from your OKI MFP, and register it in [Server Name
List].

Server Name

Enter the desired LDAP server in this box if needed.

Tip
Up to 64 characters (excluding # ; \ =) can be entered for the [Server Name] box.

[Add]
Click this button to register the LDAP server in the [Server Name List], which has been entered in the [Server Name]
box.

Server Name List
The registered LDAP servers are displayed in this list. Up to 8 LDAP servers can be registered.

[Delete]
Click this button to delete an LDAP server in [Server Name List]. Select the LDAP server that you want to delete in the
list, and click this button.
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Sending With Extended Fax Functionality

The Fax driver allows users to perform the following features.
P.31 “Saving a fax as a file”

P.32 “Delayed transmission”
P.33 “Sending with a cover sheet”

l Saving a fax as a file

You can save a document in the “TXFAX” folder in the “FILE_SHARE?” folder in this equipment as well as sending the n
document to fax numbers and Email addresses.

1 Display the [Send] tab and select the [Save as File] check box.

(%% Printing Preferences @

| Layout | Send

Sendto BS

[ Address Book... |
To

Dizplay Mame Fax Mumber ¢ Addiess

[ @ Fax Mumber
[ Intermet Fax Address

ﬂ R esolution: m__\JDEpartmenthda
B | Standard (200 = 100 dpi) G|

/| Hide Department Code

. Cover Sheet: Server Mame:
[Qh | Hane % ‘ = Select fram -~ -
(D) [DeayedFar 11A1/2001 511 FM
Y WSamakld File Format
= Q [ TIFFMULTI) -
[ i 2? Defaults | [ Help ]
[ )

2 Select the file format in the [File Format] box.

\_l) | Delayed Fax 5¢10/2011 311 PM

X [Fl5ave asFie File Format:
TIFF(MULTI) =

\ Fiestors Defauls | TIFFSINGLE) [ Heb |
FOF(MULTI)  ——
POF(SINGLE) = —
— | K || Cancel |

3 Specify the other options to send a document and click [OK].

4 Click [OK] (or [Print]) to send a document to this equipment.
The document is saved in the “TXFAX” folder in the “FILE_SHARE” folder in this equipment.
Tips

¢ The saved file contains the cover sheet when the cover sheet is set.

* Since the image smoothing function does not work for the image stored in the “FILE_SHARE” folder, its
printing image quality differs from the normal fax image quality.

Sending With Extended Fax Functionality 31



H Delayed transmission

When the delayed transmission is specified, the fax is stored in the fax queue in this equipment and will be sent at the
specified date and time.

1 Display the [Send] tab and select the [Delayed Fax] check box.

(%% Printing Preferences @

| Layout | Send

Sendto 1
| Address Bovk... |
To

Dizplay Mame Fax Mumber / Addiess

[ @ Fax Mumber
[ Internet Fag Address

ﬂ R esolution: = Department Code:
B | Standard (200 100 dpi) v )
/| Hide Department Code
. Cover Sheet: Server Mame:
[Qh | Mone & ‘ == Select from - b |
\9 111720011 B12PM | Edi... |
':_ % as File
2 TIFF(MULTI)
{ Restore Defaults | Help |
)

9 Click [Edit].
The [Scheduled Time] dialog box appears.

3 Select the date and time and click [OK].

Scheduled Time

Date: B2 02011 E Time:  9:28 PM z

| Qg [: | | Cancel |

* You can click the Date arrow to display a calendar that allows you to select a date.
* Enter the time to commence the fax transmission. You can use the up and down arrows to assist with setting
the time in the proper format.

The scheduled date cannot be more than one month from the current date. If the current month does not have
a date like the current one, then the date will be set at the last day of the following month. For example, if the
current date is March 31st, then the maximum date that can be selected for the scheduled fax is April 30th.

4 Specify the other options to send a document and click [OK].
5 Click [OK] (or [Print]) to send a document to this equipment.
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H Sending with a cover sheet

You can choose to send a cover sheet with your fax transmission. The cover sheet is merged with the recipient [To] list

data to create a fax cover sheet. You can select what to include on the cover sheet such as sender or recipient
information.

When a printer driver whose name consists of 54 letters or more is specified for the default printer and an attempt is

made to send a fax with a cover sheet added from Microsoft Excel using a Fax driver with an IPP port, an XL error may
occur and fax transmission may be impossible. (This error does not occur in application software other than Microsoft

Excel.)
If this error occurs, perform one of the following and start sending a fax again.

1

Use 30 letters or less for the Fax driver name.
Do not attach any cover sheet.

Display the [Send] tab, select the cover sheet type in the [Cover Sheet] box and then

click [Edit].

2 Printing Preferences
Lapout | Send

Sendto
| Address Bouk..
Io

Display Name Fax Number / &ddriess

[l @ Fax Number

& Internet Fax Address

ﬁ Fesolytion; = )Daparlmenlguds
B | Standard (200 100 dpi] 1

/| Hide Department Code

==

Cover Sheet: Server Mame:
& [Bandard Ever Page T ¥ | o Sielect fiom - z
\9 Delayed Fax 1141 ,3\ E12PM
‘_ Save as File
TIFFMULTI)
[ Bestore Defaults [ Help J
i)

The [Cover Sheet Settings] dialog box appears.

Sending With Extended Fax Functionality 33



2 Enter the title of the cover sheet in the [Header Text] box.

Caover Sheet Settings

==

Caver Sheet Name:

| FACSIMILE TRANSMITTAL | Skandard Cover Page

Header Text

FACSIMILE TRAMSMITTAL

Text Area Details

Reeference Mumber

Recipients Information

Mame company
Department Mame Fax Mumber
Sender Information
Fonts
Faonit For;
Header > ‘ | Edit. |
Footer
o | Subject:
Image File:
Browse... |
- |Message
Restore Defaults
ak | | Cancel ‘ | Help

You can enter up to 63 characters for the header text.

If you want a reference number identifying the document to appear on the cover sheet,

select the [Reference Number] check box and then enter the reference number in the
text box.

Caover Sheet Settings

=

Caover Sheet Name:
ISR EAG SN LT MMITTRLCE] Standard Cover Page
Header Text

FACSIMILE TRANSMITTAL

Text Area Details

| Reference Mumber
000o0a0a01

ELELIIET I L Or e

Mame Company

Department Mame Fax Mumber

You can enter up to 20 characters for the reference number.
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If you want the recipient’s information to appear on the cover sheet, select the

[Recipient Information] check box and then select the options required for the recipient
information.

Caover Sheet Settings

Caver Sheet Name:
Standard Cover Page

| FACSINLE TRANSHITTAL |

Header Text

FACSIMILE TRAMSMITTAL

Text Area Details

V| Reference Mumber

0000000001

/| Recipients Information
| Mame V| Campany
7] Department Mame 7] Fax Murnber

Fonts

Name — Check this to have the name of the recipient appear on the cover sheet.

Company — Check this to have the company name of the recipient appear on the cover sheet.

Department Name — Check this to have the department name of the recipient appear on the cover sheet.

Fax Number — Check this to have the fax number or Email address of the recipient appear on the cover sheet.

* Recipient information is obtained from the address book. If the recipient is added manually, this information
does not appear on the cover sheet except for the fax number or Email address.
* The recipient information for all recipients will appear on the cover sheet.

If you want sender information to appear on the cover sheet, select the [Sender
Information] check box and then enter the sender information in the text box.

| Recipients Information
7| tame 7| Compary
| Denartment Mame: 4| Fax Murher
| Sender Information
Sponsored: 0O000 CORPORATION
Fonts. Supported: ABCD CORPORATION
Fanit For:
Header hd ‘ | Edit...
Fonter
R
Image File:
Browse...
Message
Restore Defaulks
I (a9 I | Cancel ‘ | Help

You can enter up to 500 characters for the sender information.
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6 If you want a subject to appear on the cover sheet, select the [Subject] check box and
then enter the subject in the text box.

V| 5ender Information
Sponsored: OO000 CORPORATION

Fonts Supported: ABCD CORPORATION
Fant For:
|Header ~ ‘ | Edit... |
Footer
| 5ubject
Image File:

| Information
Browse...

Restore Defaulks

l (a9 Il Cancel H Help

You can enter up to 40 characters for the subject.

7 If you want a message to appear on the cover sheet, select the [Message] check box
and then enter the message in the text box.

V| 5ender Infarmation

Sponsared: OOOO0 CORPORATION

Fants Supported: ABCD CORPORATION
Fant For:
|Header v ‘ | Edit... |
Faoter
| 5ubject
Image File:

Information
Browse...
| Message

Flease refer to the attached information,

Restore Defaults

| Ok || Cancel H Help

You can enter up to 500 characters for the message.

If you want to change the font of the characters on the cover sheet, select the
corresponding section in the [Font for] box, and then click [Edit].

‘ ‘ V| Sender Information
Sponsored: OOGGO CORPORATION

Fants Supported: ABCD CORPORATION
Fant for:

Header =/ | Edit... |

Title | [ :§ .

Fiody 1 2 ¥ Subject

AR

- Information
Browse...
| Message

Flease refer to the attached information.

Restore Defaults

I oK || Cancel Jl Help

The [Font] dialog box appears.

If you do not change the font, proceed to step 10.

Sending With Extended Fax Functionality



9 Select the desired one from each of the [Font], [Font style], [Size] and [Script] boxes,
and then click [OK].

Font @
Font: Font style: Size:
Arial Bald B
R - Feow | 2 -
Calibri |izati 5
Cambria [Bold |28
|Cambria Math |Bold Itaiic £
|Candara |Black ;fa
Comic Sans S~ |Black obiigue |

Sample

Scopt:

Westemn -
Show maore fonts

| QK ‘ Cancel |
Y 4

The [Font] dialog box is closed and the font settings are determined for the selected section.
Tip
If you want to change the font of other sections, repeat the procedure from step 8.

1 0 If you want to attach an image file on the footer, click [Browse] of Image File.

V| 5ender Infarmation

Sponsared: 00000 CORPORATION

Fants Supported: ABCD CORPORATION
Fant For:
|Header v ‘ | Edit... |
Faoter
V| 5ubject
Image File:

Information

| Message

Flease refer to the attached information,

Restore Defaults

(o4 || Cancel H Help

The [Open] dialog box appears.

If you do not attach an image file, proceed to step 13.

Sending With Extended Fax Functionality 37



11 Select an image file to be attached and then click [Open].

El Open

€1

Organize =

. ¢ falogo
Mew folder

[ Favorites
B Desktop

& Downloads

FeeeE oo

FAX logo-01

1l Recent Places

A Libraries

| Documents
o Music

=| Pictures
B videos

1M Computer

ﬁ‘!l Metwork

File name: FAX lago-01

e

FAX_logo-02

FAX_logo-03

- “.hmp

T |

| Qpen . |v] | Cancel

A

W2

The [Open] dialog box is closed and the selected image file is attached.

Attach the image file in a bitmap format (.bmp) within 1 MB.

1 2 Select the position of the image file.

Caover Sheet Settings @
Caover Sheet Name:
.fiMiL-E.T.RAN.s.MIITAL Standard Cover Page
" Header Text
= FACSIMILE TRANSMITTAL
Text Area Details
V| Reference Mumber
00000o0a01
/| Recipients Information
| Mame V| Company
| Department Mame | Fax Mumber
/| 5ender Information
Sponsored: OO000 CORPORATION
Fonts Supported: ABCD CORPORATION
Faonit For;
Header X ‘ | Edit.
Footer
/| Subject
Image File: -
InFormation
FA¥_logo-01.bmp
z 7 J|Message
i Delete il Please refer to the attached infarmation.
Position:
G ErgiED
| Restore Defaulks
oK | | Cancel ‘ | Help

- Select this to align the image to the left.
- \E/ Select this to align the image to the center.
- Select this to align the image to the right.

Specify the other options to send a document and click [OK].

13
14

Click [Print] to send a document to this equipment.

Sending With Extended Fax Functionality



APPENDIX

This chapter shows the cover sheet samples.

Lo 1 T ] 1= RS- T 4 o (== 40
SEANAAIA COVET PAGE ...ttt a e sa et e et et e ettt eeh bt e e eat et e eab e e e e b e e anbe e e nn e e e aane e e eneeesannes 40
BUSINESS COVEI PAGE ... eeeeeei ittt ettt ee ettt e e ettt e e oottt e e e e et et e e e e e e hae e e e e e e amn e e ee e e e amnseeeeeeaaneeaeeaanneeeeeseannnneeeeaanne 41

ProfesSioNal COVE PAGE ........eiiiiieiiee ettt ettt st e ettt e e at e e smb e e e e bt e e eateeesaseeeanbeeeenneeesneeean 42




Cover Sheet Samples

l Standard cover page

FACSIMILE TRANSMITTAL

Reference Number:
0000000000000000
To:
00000000001
From:
XXX-XXXXXXXX
Subject:

Fax Document

Message:
This is a Fax Document.

.

40 Cover Sheet Samples



H Business cover page

FACSIMILE TRANSMITTAL SHEET

Reference Number:

0000000000000000
To:

00000000001
From:

XXX-XXXXXXXX
Subject:

Fax Document
Message:

This is a Fax Document.

Cover Sheet Samples 41



M Professional cover page

FACSIMILE TRANSMITTAL SHEET

Reference Number:

0000000000000000
To:

00000000001
From:

XXX-XXXXXXXX
Subject:

Fax Document
Message:

This is a Fax Document.

42 Cover Sheet Samples
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L
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P
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REMOVE ..ot 24
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FaX driVEr ..ceieiiei e 29
SNMP e 27

INDEX 43



44 INDEX



ES9460 MFP/ES9470 MFP
CX3535 MFP/CX4545 MFP
ES9160 MFP/ES9170 MFP



Oki Data Corporation
4-11-22 Shibaura, Minato-ku,Tokyo
108-8551, Japan

www.okiprintingsolutions.com

45105902EE



	Preface
	How to read this manual
	Symbols in this manual
	Screens and Operation Procedures
	Trademarks


	CONTENTS
	OVERVIEW
	Features and Functions

	SENDING A FAX
	Basic Procedure
	Specifying Recipients
	Entering recipients from the keyboard
	Selecting recipients from the address book
	Selecting recipients from the address book (Search option)
	Removing recipients


	SETTING OPTIONS
	How To Setup
	Setting Initial Values of the Fax driver options
	Setting print options for each print job

	Setting up the Fax Driver Options
	Setting up the [Layout] tab
	Setting up the [Send] tab
	Setting up the Cover Sheet
	Setting up the SNMP
	Setting up the [Device Settings] tab
	Setting up LDAP servers

	Sending With Extended Fax Functionality
	Saving a fax as a file
	Delayed transmission
	Sending with a cover sheet


	APPENDIX
	Cover Sheet Samples
	Standard cover page
	Business cover page
	Professional cover page


	INDEX

